Inside This Edition

Excel Accelerated

Battle of the Smartphones

Career Center

Flights without Fright
FINDING A FLIGHT WITHOUT FRIGHT

BY: AL-VIRAH KABANI

We all miss home-cooked meals and lounging at our local hangouts. But we often miss the opportunity to go home, or on a small vacation, because of the rising cost of airfare.—Remember, “where there is a will, there is a way.” If you play your cards right, and do your research; going home, ‘spring-breaking’, or spending a summer abroad can be within your financial reach!

Book as early as possible!

It is never too early to book your flight home. Many students wait to book at the last minute, not realizing that waiting to get a ticket can cost you more. Most websites reward you for booking early, by giving you the opportunity to name your price, offering special promotions and discounted fare as a reward for being an early bird. Whether heading home, planning your break, or just visiting a friend, booking early will always help you lock-in the best rate.

Websites such as: Student Universe and STA Travel.

Student Universe offers deals just for students! What can be better for you than a website designed to seek out the cheapest and most convenient ticket for you? Student Universe digs through many different search engines and airline website, and filters through the prices and stops for you. For long distance or international travel, STA Travel offers great deals for trips to places like London, France, and Spain. Besides being a great resource to book tickets—with the student budget in mind—STA Travel allows you to search for essentials such as: flights, tours, rail pass information, insurance information, volunteer opportunities, work abroad opportunities, and destination information. These one-stop fixes for all your spring break needs give you a chance to experience your vacation without you worrying about exceeding your budget.

Look into instant refunds and cross checking sites.

Websites like Orbitz offers you a refund if tickets get cheaper, AND cross checks your flights with other sites before booking. We often overlook flight times, airports, or connections, and find ourselves in a bind the day we fly. Remember that the point of the internet is to make your life easier. Why attempt to dig through different deals when you can make the website do it for you? Make use of the ‘search other sites’ option offered by most booking websites; it is there to make your life easier.

Book ‘complex round-trips’ if you know you will be coming home on certain breaks.

It is never a bad idea to plan your trips. Though this requires some effort, booking round trips from the end of one break to the beginning of another, can really help your pocketbook. For example: fly in for the first day of classes, and book your return for the first day of October break; your next ticket can be from the last day of October break to the beginning of Thanksgiving. Booking ‘complex round trips’ keeps you away from competing for popular fly days and gives you a definite flight schedule for the major breaks. The only downside to this option is that if you decide to move a flight after you have already booked, you can be charged a flight change fee of up to seventy-five dollars. (Remember: as long as you are fully committed to your travel plans, this should not be an issue for you.)

Look into credit cards that offer flight benefits.

If you are aware of your spending, or have parents that own a business— look into credit cards that offer flight benefits from your spending. Flight points and frequent flyer miles can help you travel by covering a portion of your flight cost, or your entire flight cost. Though this can be one of the best ways to save money on flights, it is easy to get carried away with credit cards. So make sure you understand the interest rates, payment plans, and your own personal finances before acquiring any type of credit card. Keep in mind that credit cards are not liquid cash, if you don’t have the money to pay the statement, don’t make the purchase.

Try being flexible:

Programs like AirTran U, offer standby flights cheaper that confirmed flights. If you are a student from the ages 18-22, AirTran offers you the option to fly standby to most cities for $49-$69 dollars (one way). Flying standby can be burdensome during popular fly times. But keep in mind that if you don’t get a flight to your destination, AirTran will refund your standby ticket. Although flying standby offers students a great way to get around at a reasonable price, there are some shortcomings involved with flying AirTran U including: inability to fly on blackout dates, baggage restrictions, and the struggles associated with finding connecting flights. Standby flights are a great option for students on a budget, if they are willing to be patient.
Writing cover letters is extremely important in the job search process. Your cover letter is your one page introduction to the employer. If a cover letter is written well, employers will be encouraged to find out more information about you and extend you an interview. Below are a few tips for effective cover letter writing:

**Address your cover letter personally.**
You should never address your cover letter to “Dear Sir” or “To whom it may concern”—this shows that you did not take the time to find out who will be reading your application and resume. Call the office and find out the necessary information to personally address your cover letter. Going the extra mile shows your interest in the job, and can also be used as a networking tool as you talk to employers in the office.

**Say no to generic cover letters.**
Sending the same cover letter to different jobs will quickly get your application thrown in the bin. Write a new cover letter for every job you apply to. Tailor your letter by showing specific company, positional, and product knowledge. Also, show how your abilities align with the company’s goals and mission statement.

**Pay attention to detail.**
You are being judged by your cover letter. Therefore, put your best foot forward. Any typos, misspellings, or incorrect information will get your cover letter thrown away. Proof read and check your cover letter thoroughly before you send it in. Have someone else proof read it, and check everything yourself once again. It is better to be safe than sorry.

**Be professional, friendly, and original.**
Cover letters are a great way to reveal your personality. You want to show that you are a great fit for the position while getting the reader to understand and choose you for the position. Use appropriate humor, catchy sayings, and a professional tone to help draw the reader to you. This will also help you stand out amongst your peers.

**Keep your cover letter to one page.**
Less is more when it comes to a cover letter—your goal is to convince an employer in one page to give you an interview. Keep your cover letter simple and brief by tailoring your letter to each specific company. This will allow you to highlight your skills that are applicable for the job.

**Market yourself.**
You are selling yourself in your cover letter. Use high impact words to give yourself a competitive edge amongst peers who are applying for the same jobs. Also, draw attention to your skills, strengths, and accomplishments that will be relevant in the line of work you are applying for. Self-promotion is very important in cover letter writing and since you know yourself the best, use it to your advantage.

**Follow-up**
It is very important that you follow up after sending in your cover letter and resume. It shows initiative when you call the employer directly after writing, instead of just waiting for a call. However, if you are given specific instructions to not call the employer after you send in your cover letter and resume, please take heed to these directions.

Your cover letter should be the best representation of yourself. You have one page to sell yourself to employers and get the point across that you are the best qualified applicant for the position. Remember, what you put in is what you get out. Use the above tips to help you construct the cover letter that will get you the job.

For more information about cover letter writing, visit the Career Center at Emory University.
Excel is one of the most important software products in the workplace today. Whether working, interning, or volunteering, it is becoming increasingly important to know and understand how to build spreadsheets on Microsoft Excel. Practical uses for Excel include, but are not limited to: managing your finances, creating a calendar or schedule, planning or managing projects, creating complex lists, creating basic databases, creating address books, and creating graphs or charts from data. Below are some basic functions and shortcuts you can use to get you started in your learning process:

Let’s start with a review of the parts of the screen—this will be your point of reference throughout our tutorial:

<table>
<thead>
<tr>
<th><strong>Title Bar</strong></th>
<th><strong>File Tab</strong></th>
<th><strong>File</strong></th>
<th><strong>Save</strong></th>
<th><strong>Save As</strong></th>
<th><strong>Open</strong></th>
<th><strong>Share</strong></th>
<th><strong>Help</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name Box</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>File Tab</strong></td>
<td><strong>Name Box</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>File Tab</strong></td>
<td><strong>Name Box</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
</tr>
<tr>
<td><strong>Workbook</strong></td>
<td><strong>Title Bar</strong></td>
<td><strong>File Tab</strong></td>
<td><strong>File Tab</strong></td>
<td><strong>File Tab</strong></td>
<td><strong>File Tab</strong></td>
<td><strong>File Tab</strong></td>
<td><strong>File Tab</strong></td>
</tr>
<tr>
<td><strong>Rows</strong></td>
<td><strong>Columns</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
</tr>
<tr>
<td><strong>Scroll Bars</strong></td>
<td><strong>Zoom Slider</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
</tr>
<tr>
<td><strong>Worksheet Tabs</strong></td>
<td><strong>View Buttons</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
<td><strong>Quick Access Toolbar</strong></td>
</tr>
</tbody>
</table>

**Fundamentals:**

Anytime you need help press <F1> to open the Help window—type your question <Enter>. To select a cell, click completely on the cell. Each cell is assigned a cell address—each cell is called according to its column letter and row number (ex- A4).

<table>
<thead>
<tr>
<th><strong>Task</strong></th>
<th><strong>Action</strong></th>
</tr>
</thead>
</table>
| To Open a Workbook:       | Click the File tab and click <Open>.
| To Save a Workbook:       | Click the File tab and click <Save>.
| To Create a New Workbook: | Click the File tab, click the <New> tab, and click <Create>.
| To Print a Workbook:      | Click the File tab and click the <Print>.
| To Undo or Redo:          | Click the Undo/Redo button on the Quick Access Toolbar. ( undo )
| To Select a Cell Range:   | Click and drag the outlines of the cells you want to select in your range.
| To Minimize the Ribbon:   | Click the Minimize Ribbon button on the Title Bar.
| To Zoom In or Out:        | Click and drag Zoom slider to the right or left.
| To Close a Workbook:      | To exit, click the <Close> button on the right hand of the toolbar.

Continued on page 6
### Basic Editing:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Cut, Copy, or Paste:</td>
<td>Select cell and select the needed button in the Clipboard group on the Home tab. To paste, place in insertion point where you want to paste and click the Paste button in the Clipboard group in the Home tab.</td>
</tr>
<tr>
<td>To Clear a Cell’s Contents:</td>
<td>Select the cell(s) and press the <code>&lt;Delete&gt;</code> key.</td>
</tr>
<tr>
<td>To Copy Using Auto Fill:</td>
<td>Point to the fill handle at the bottom-right corner of the selected cell(s), then drag to the destination cell(s).</td>
</tr>
<tr>
<td>To Complete a Series using Fill:</td>
<td>Select the cells that define the series. Click and drag the fill handle to complete the series.</td>
</tr>
<tr>
<td>To Insert a Column or Row:</td>
<td>Right-click to the right of the column, or below the row you want to insert. Select <code>&lt;Insert&gt;</code> from the contextual menu, or click the <code>&lt;Insert&gt;</code> button in the Cells group on the Home tab.</td>
</tr>
<tr>
<td>To Delete a Column or Row:</td>
<td>Select the row/column heading(s). Right-click and select <code>&lt;Delete&gt;</code> from the contextual menu, click the <code>&lt;Delete&gt;</code> button in the Cells group on the Home tab.</td>
</tr>
<tr>
<td>To Insert a Comment:</td>
<td>Select the cells where you want to insert a comment and click the <code>&lt;Review&gt;</code> Tab on the Ribbon. Click the <code>&lt;New Comment&gt;</code> button in the Comments group. Type a comment and click outside the comment box.</td>
</tr>
</tbody>
</table>

### Formulas, Functions, and Charts:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Total a Cell range:</td>
<td>Click the cell where you want to insert the total and click the <code>&lt;SUM&gt;</code> button in the Editing group on the Home tab. Verify and Click <code>&lt;SUM&gt;</code> again.</td>
</tr>
<tr>
<td>To Enter a Formula:</td>
<td>Select the cell where you want to insert the formula. Type <code>&lt;=&gt;</code> and ender the formula using values, cell references, operators, and functions. Press <code>&lt;Enter&gt;</code> when your formula is complete.</td>
</tr>
<tr>
<td>To Insert a Function:</td>
<td>Select the cell where you want to enter the function and click the <code>&lt;Insert Function&gt;</code> button on the Formula bar.</td>
</tr>
<tr>
<td>To Reference a Cell in a Formula:</td>
<td>Type the cell reference in the formula.</td>
</tr>
<tr>
<td>To Create an Absolute Reference:</td>
<td>Precede the cell references with a <code>&lt;$&gt;</code> sign.</td>
</tr>
<tr>
<td>To Use Several Operations:</td>
<td>Enclose the part of the formula to calculate in the parentheses.</td>
</tr>
<tr>
<td>To Create a Chart:</td>
<td>Select the cell range that contains the data you want to chart and click the <code>&lt;Insert&gt;</code> tab on the Ribbon. Click a chart type button in the Charts group and select the chart you want to use from the list.</td>
</tr>
<tr>
<td>To Insert a Sparkline:</td>
<td>Select the cell range that contains the data you want to chart and click the <code>&lt;Insert&gt;</code> tab on the Ribbon. Select the sparkline you want to insert from the Sparkline group. Select the cell or cell range where you want to add the sparkline and click <code>&lt;OK&gt;</code>.</td>
</tr>
</tbody>
</table>
Emory’s career center is one of the University’s greatest resources. With services such as networking nights, and Eagle Ops, the computer site that assist students in their search for part time and full time jobs, the career center has helped students attain success in their professional and academic endeavors.

According to the website, the goal of the Emory Career Center is to advise and assist students about career decision making, employment opportunities, academic programs, and internships that will enhance their skill set.

The career center is truly one of Emory’s gems. According to Britney Fields, the advisor for Double majors and Economics majors, companies such as Citi, Google and Wells Fargo have complimented Emory on the career center. When Pricewaterhousecoopers came to conduct their interviews, they played Wii with prospects as they waited for their interview times.

The career center has conveniently moved to the Boisfeuillet Jones building from its previous location at the North Decatur Building. Now that the center is on the main campus, students use the center more often. Since its opening in September, the center has seen an increase of 250 more appointments. From September to Mid-October, seniors (Emory college class of 2011) used the career center’s services the most at 46%. For more information on the breakdown of the students who use the career center, please see the chart on page 12.

The earlier a student comes into the Career Center, the easier it is to help them discover their professional path. A student may feel completely lost when they walk into the center, but the center provides the student with everything they could possibly need. Beginning steps include personality and career assessments as well as advising. The important fact to remember about the career center is that no matter what your major is, there is an advisor for your specific interest.

The career center offers an array of helpful services. For a list of complete services, please see the chart on the next page or visit the career center website. The benefits of using these services are huge. The career center is staffed with experts who can provide guidance on things such as writing cover letters to how to dress properly for an interview. Imagine receiving information from these experts about exactly what you need to do to get where you want to be professionally.

Some well-known Career Center programs include Resumania, where students receive critiques on their resumes for fifteen minutes from advisors and recruiters. The center also sponsors Fall and Spring career fairs, where recruiters from business, education, government, non-profits and other lines of businesses come to interact with students and alumni. Another well-known program that the center sponsors is the graduate school fair where representatives from many law schools, business schools and other graduate programs come to interact with students.

One service that Britney Fields finds extremely beneficial is Mock Interviews. The official Mock Interviews are offered twice in the Fall and once in the Spring. Although mock interviews are available anytime with an advisor, these Mock Interviews are held with actual recruiters and allows students to get a real interview experience without any consequences. Although more students in the Business School use Mock Interviews than any other schools, these programs are held with the College in mind.

The earlier a student comes into the Career Center, the easier it is to help them discover their professional path. A student may feel completely lost when they walk into the center, but the center provides the student with everything they could possibly need. Beginning steps include personality and career assessments as well as advising. The important fact to remember about the career center is that no matter what your major is, there is an advisor for your specific interest.

The career center offers an array of helpful services. For a list of complete services, please see the chart on the next page or visit the career center website. The benefits of using these services are huge. The career center is staffed with experts who can provide guidance on things such as writing cover letters to how to dress properly for an interview. Imagine receiving information from these experts about exactly what you need to do to get where you want to be professionally.

Some well-known Career Center programs include Resumania, where students receive critiques on their resumes for fifteen minutes from advisors and recruiters. The center also sponsors Fall and Spring career fairs, where recruiters from business, education, government, non-profits and other lines of businesses come to interact with students and alumni. Another well-known program that the center sponsors is the graduate school fair where representatives from many law schools, business schools and other graduate programs come to interact with students.

One service that Britney Fields finds extremely beneficial is Mock Interviews. The official Mock Interviews are offered twice in the Fall and once in the Spring. Although mock interviews are available anytime with an advisor, these Mock Interviews are held with actual recruiters and allows students to get a real interview experience without any consequences. Although more students in the Business School use Mock Interviews than any other schools, these programs are held with the College in mind.

The career center advising is designed to service the College exclusively and there has been a rise in the participation of fairs. Seven hundred students attended the Majors Fair this year and five hundred students attended the Graduate School Fair.
Receiving a great education is usually never free. The cost to attend Emory is roughly $23,000 per semester. Some Emory students have scholarships to aid in the cost while others will take out loans to pay for their education. Understanding and repaying your student loans now will be an important factor in repaying your student loan.

The most important step in repaying student loans is knowing what loans you have and the terms of those loans. Keep a record of your lenders, balances, disclosure statements, promissory notes and repayment schedules for each of your student loans. These important documents will play an important role once you enter payment.

Different loans have different grace periods. The grace period is how long you have after graduation until you have to make your first payment. Consequently, you should know the grace periods of your loans and create a payment schedule for each loan. Do not miss your first payment as this could hurt your credit score.

Choosing the right repayment option for you is crucial in your journey to repaying your debt. When your federal loans become due, your loan payments will be based on a ten year repayment plan. If this payment plan is too hard for you, you must contact your lender to discuss and arrange other repayment options that is right for you. Extending the payment plan will lower your monthly payments and make it easier for you to meet the monthly payments. However, you will accrue more interest over the life of the loan. Repayment plan options include: standard repayment plan, income-based repayment plan, graduated repayment plan, extended repayment plan, income sensitive or income-contingent repayment and consolidation.

Do not ignore your student loans! Not paying your loans can lead to delinquency and default. When you default, your total loan balance becomes due. Your credit score plummets and the total amount you owe increases dramatically. For federal loans, default occurs after nine months of not making payments. For private loans, default can happen much sooner and can put anyone who co-signed on your behalf at risk. Talk to your lender as soon as possible if you are having trouble repaying as agreed.

Lower your principal if you can. In general, when you make a federal loan payment, it covers any late fees, then interest and lastly the principal. If you can pay more than the required monthly payment, do so. The extra amount will be applied to the principal which will reduce the amount of interest you have to pay for the loan. Make sure you write to the lender to clarify that you would like the extra money to be applied to the principal.

Like credit cards, you should pay off the most expensive loans first. Start paying off the loans that have the highest interest rates. If you have both federal and private loans, start with your private loans as they will generally have higher interest rates and lack the flexible repayment options that federal loans have.

It is never too early to develop your game plan for repaying your student loans. The earlier you prepare the better. Repaying your students loans can be a burden. However, it doesn’t have to be with the right knowledge and guidance. Follow these tips and consult with your financial aid advisor or your lender if you have any concerns about your federal and private loans.

Important Repayment Terms

**Deferment** - A deferment allows you to postpone your scheduled loan payments. During the deferment period, the federal government will pay the interest on subsidized loans.

**Forbearance** - A forbearance allows the temporary postponement or reduction in the principal payments for up to one year.

**Cancellation** - Loans will be cancelled in the event of the borrower’s death or if the borrower become completely disabled after the loan is distributed.
During the past few years, smart phones have become all of the rave. With functions such as surfing the web to video chatting, having a smart phone in your pocket is like having a handheld computer built within your mobile device. According to a study by ComScore, 45.5 million people in the United States owned smart phones in 2010. Although there are over dozens of smart phones in the market, three have set themselves apart from the pack: the Iphone 4GB, Blackberry Curve, and the Android. With so many options for a smart phone, here is a guide for the top three selling mobile devices.

**Apple Iphone 4GB**

**Pros:** Apple’s newest Iphone, that was released this summer, has a newer sleek design and a multi-touch user interface. Users have praised its Safari browser that makes the surfing experience on the Iphone faster and easier. In addition, the Ipod feature on the phone is superb.

**Cons:** Many Iphone users have complained about the 4G’s antennae and variable call quality. It also lacks stereo Bluetooth support and 3G compatibility. As an ipod, you have to sync the Iphone to handle music content.

**Overview:** Although the Iphone 4GB has call quality problems and a slow data network, the smart phone sets a new standard for an integrated cell phone and MP3 player. In addition, users have praised the resolution, graphics and design of the phone.

**Blackberry Curve 8530**

**Pros:** The blackberry Curve has a fashion forward designed that is aimed at a younger audience. The curve is smaller than the Tour but is still a solid phone that can handle multiple drops. In addition, the blackberry curve has wi-fi and a touchpad versus the trackball that can have complications.

**Cons:** The processor on the Curve is less powerful than some of its contemporaries and the call quality is just average.

**Overview:** Generally, the Blackberry Curve is a solid performer but its processor and call quality are average. The curve has a3G Sprint antennae, GPS, Bluetooth and Wi-fi which is not available on the earlier models. This model also includes Blackberry Apps such as Pandora and office suite.

**Motorola Droid Pro**

**Pros:** The Droid Pro runs the Android OS 2.2 operating system which means it supports Adobe Flash. The smartphone also has 2 GB of internal storage and a 2 GB micro SD memory card.

**Cons:** Users have complained that the Droid Pro’s touchscreen freezes sporadically. In addition, the life of the battery is short due to the apps ad operating system of the Droid.

**Overview:** This smart phone is both business and user friendly. The Droid Pro also has a touch screen and keypad that makes it stylish and easy to use. With internal space and a memory card, the Droid is a great smartphone for storage.

Use this guide to find the best smartphone for you. At the end of the day, your smartphone should be convenient and work best for what you do and who you are.
**Profits Aren’t Everything, They’re the Only Thing**

Rating out of 5: 4

George Cloutier’s book *Profits Aren’t Everything, They’re the Only Thing*, contains rules for small business owners, and is a life skills guide every student should read. Cloutier is the chairman and founder of company called American Management Services, a management firm that aims to transform failing small business into thriving ones. Though this book focuses on small businesses, it can be applied to the way most individuals think about their life and finances. Chapters like “End Denial” and “It’s Not the Economy, Stupid, It’s You!”, shock the reader into understanding the severity of their own actions. After each chapter, Cloutier gives a “Flash Report” that highlights the purpose and importance of each chapter.

Although controversial, reading this book can truly help ‘snap’ someone back to reality. Cloutier, though intending to help small business owners, gives advice that can apply to anyone in a financial crisis. Knowing that many college students face financial issues because of their inability to plan, pay attention to personal finances, and habits of collecting outstanding tabs, college students often face the same problems a small business owner would. I would not go as far as Cloutier does to promote us all to become money making machines—but weighing his advice, it is easier to formulate a game plan to gain control of our finances. If the reader can take the corporate examples and apply them to his or her own life, the advice in this book can reroute your financial future leading to not only more ‘profits’, but a more well planned future.

Cloutier uses harsh advice to remind us all that we need to be actively and aggressively involved in our monetary life to keep it healthy. By no means do I agree that abolishing teamwork, putting finances before family, and only blaming yourself is the answer to your financial problems. However, if we did use each of these concepts in moderation, I strongly believe that we would be better personal financiers. Often times, we forget that being passive about our finances is what causes our financial downturn. By reading *Profits Aren’t Everything, They’re the Only Thing*, an individual can assure his or herself the skills needed to understand their mistakes and the gain tools to improve their situation.

**I Will Teach You To Be Rich**

Rating out of 5: 5

Ramit Sethi’s *I Will Teach You to Be Rich*, is a book I cannot praise enough! Sethi’s book goes hand in hand with his blog, which offers concrete advice and examples targeted specifically toward 20-35 year olds. This book is structured as a six week program with the following break down: Credit Cards, Bank Accounts, Investing Accounts, Conscious Spending, Automatic Money Flows, and Investing Choices. Week one focuses on optimizing credit cards and improving your credit history. Week two explains how to find compatible bank accounts and work around certain required fees. Week three, Sethi helps readers to open a 401(k). In week four, Sethi leads readers through his process of manufacturing a “spending plan” to encourage being aware of where exactly your money goes. Week five focuses on linking your new financial roads and getting into habits to automate your financial success. The final week is a very basic introduction to investing—reminding the reader that though investing is portrayed as difficult and complicated, it can be for anyone.

Unlike many personal finance books, Sethi understands that most readers will not understand right away, and builds a base for the readers before attempting to explain more complex things. In addition to being easy to understand, this book is vivid and keeps the reader laughing throughout.

(Continued on page 13)
I Will Teach You To Be Rich (Cont’d)

This book offers advice to individuals of all backgrounds—whether new to personal financing, or already an efficient personal financier. Sethi’s six week plan will lead you, step by step, to a sound financial future. I speak from experience when I say that Sethi’s approach works! After reading his guide and implementing the steps as closely as possible, I have noticed that not only do I understand my finances better, I have already started making financially wise decisions innately. Ramit, takes the time to include ‘guest’ chapters by other financial bloggers to allow the reader to expound upon their knowledge. He also includes statistics to back up any claims or offers he makes in favor of any accounts or programs.

Along with taking the time to read this book, I strongly recommend everyone to visit Sethi’s blog at: www.iwillteachyoutoberich.com. The blog contains articles about relieving debt, negotiating fees, and choosing the right path to your financial success. To accompany the blog, you can sign up for a free newsletter that will provide you with special information not in the book or on the blog. Sethi also offers a connecting program called Earn1K, which is designed to help you form a freelancing project to increase your income even with little experience. Unlike many other newsletters and programs, that rarely apply to your daily activities, Sethi’s newsletter and blog provide everyday advice and tips that will prove useful in reforming your financial habits. Sethi is offering an opportunity you do NOT want to miss!

WHY READ?

As students, we often face financial issues because of the rising cost of education and the inability to have a steady income. Student loans are becoming common and readily available forcing us to take on an immense post-graduation burden. We often fail to realize that though helpful, student loans will become a large part of our financial future. Interest begins to accumulate and the already large sum becomes much bigger when we are trying to afford our first apartment, our first car, or graduate school. Many students choose to delay saving to repay debt and lose the opportunity to get a steady start to their financial future.

Financial literature can help you realize what you need to do to keep your financial future on track. Reading financial materials can help you gain the skills you need to budget, manage, and alter your finances specifically to your needs. Keeping yourself aware of your finances will ultimately help you make the necessary choices to prevent you from drowning in debt. It is never too late to start learning about personal financing—remember that no matter where you stand financially; there is ALWAYS something you can do to gain momentum towards the direction you would like to go. It is YOUR life—learning about your finances will keep you in control.
Although predicting employment trends depends on the overall economy, the career center has noticed some trends. Marketing, advertising, creative writing, and journalism professions are all opening up according to the needs of companies. Recruiting for these companies usually take place in mid-spring. The center has seen an increase in the openings of positions in consulting, finance and banking from the last three years. This influx of positions serves as a bonus for students because recruiting can take place year-round. Although many companies look for qualifications to fulfill the position, very few look for a certain major. Experience almost always outweighs majors.

Another bonus of the Career Center is that it offers free services to Alumni up to two years after they graduate. Those beyond two years will have access to career counseling through the Emory Alumni Association. Also, the Emory Career Network database provides online access to alumni mentors who are willing to discuss career options in various industries.

Emory’s Career Center is a great resource for students. The earlier a student uses its service the better. The Career center is open Monday thru Friday 8:30am-5:00pm. For more information on scheduling appointments and services offered, please visit the Career Center’s website at www.career.emory.edu.

Career Center Services

Career counseling and Pre-professional advising
Counselor office hours
Formal career assessment
24-Hour access to information via website
On Campus Recruiting
Eagle Opportunities (Eagle Ops)
Fall and Spring on campus Career Fairs
Skills workshops and panel discussions
Graduate school fair
Mock Interviewing
Document Critique Services
Dossier and Recommendation File Services
Career Center Resource Library

Who uses the Career Center?

- Seniors: 46%
- Juniors: 14%
- Sophomores: 9%
- Freshmen: 19%
- Alumni: 10%
- Other: 2%

Emory Career Center
Most people work forty plus hour work weeks to generate income. However, there is a way to sit back, relax, and still generate funds. This can be done through saving and investing. There is a way to make your money work for you.

The first step in investing is to define your goals. To end up where you want to be financially, you need a road map. Ask yourself what are the things you want to save and invest for. These goals may include saving for a car, a home or investing in one’s education. After your list of goals is created, decide the time-frame you have to complete each goal. When you save and invest, you’ll need to find the best option that fits your time frame.

After your goals and time frames are established, take a look at your current financial situation. It is hard to create a plan for your financial wealth if you do not know where you are starting therefore, completing the following step is very important. Create a list of your net worth including what you own and what you owe. Also you want to note your income and expenses. After this step is completed, you will be ready for the next step in making your money work for you.

The best savings and investing products for you depends on your goals and your risk tolerance. If you are saving or investing for a short term goal, you want to choose less risky investments. Conversely, if you are saving for your retirement that is years away, you may want to consider a riskier investment that will generate a higher rate of return. A common mistake that people make is putting money they won’t need for a while in investments that pay a low amount of interest. Once again, what option is best for you depends on your goals and time frames.

There are various ways to invest and save money. The most important factor in meeting your financial goals is the rate of return you receive on your investment. Short term saving options include savings accounts, certificate of deposits (CD) and money market funds. Your savings account is the safest place to put your money and allows you to access it at any time. Savings accounts earn a small amount of interest if you do not bother the money in the account.

Certificate of Deposits are a specialized deposit you make at a financial institution or bank. Interest is paid at regular intervals until the CD matures at which you will get the money you originally deposited in addition to the accumulated interest payments. One thing to note about CDs is that you can’t access your deposit until the CD matures.

Money Market funds are a type of mutual fund that invests in short term bonds. Money market funds pay higher interest rates than conventional savings accounts but less than CDs.

Long-term investing options are riskier than short term options but they offer higher rates of returns. The money you invest in long term investments are not insured federally and you could possibly lose the principal, which is the amount you invested. With smart investing practices, long term investments can be very lucrative. Common long-term investing options include bonds, stocks, and mutual funds.

Stocks are a way for an individual to own part of a company. As the value of the company changes, the value of the share in that company also changes. Mutual funds are a way for individuals to pool their money to buy bonds, stocks and other financial instruments. The important thing to note with mutual funds is that the responsibility of managing your money is in the hands of the fund manager.

There are many different ways to let your money work for you. The important fact to remember is that you have to find the best options to fit your needs. For more information on investing, consult a financial advisor.